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File Listing

	Task
	Exercise
	Recommended Method
	Student Data File
	Solution File

	Remove Bullets and Adjust Paragraph Indents
	10-1
	Click View, Rulers. Select the text placeholder. Remove the bullets. Click within the text placeholder.
Point to the indent markers on the ruler and drag it to the desired location.
	Outing1.ppt
	None

	Change Indents after Bullets
	10-2
	Click within the text placeholder. Drag the indent markers to the desired location.
	None
	Sol-10-2.ppt

	Set Tabs
	10-3
	Click within a text box to activate the text box ruler. Click the Tab Type button at the left end of the horizontal ruler to choose from any of the four types of tabs. Click on the ruler to set the tab and to move the existing text as per the tab setting.
	None
	None

	Edit Tabs
	10-4
	Change the position of a tabbed text column by dragging its tab marker to a new place on the ruler.
To remove a tab marker, drag it down and off the ruler.
	None
	None

	Create Column Headings for a Tabbed Table
	10-5
	Create a new text box. Key the text for the column headings. Format and align the column headings with the tabbed text. Select both text boxes and group them.
	None
	Sol-10-5.ppt

	Change Line Spacing within Paragraphs
	10-6
	Choose Format, Line Spacing. Key or select the line spacing settings in the Line Spacing dialog box.
Alternatively, click the Increase Paragraph Spacing button or the Decrease Paragraph Spacing button on the Formatting toolbar.
	None
	None

	Change Spacing Between Paragraphs
	10-7
	Open the Line Spacing dialog box. Key or select the Before paragraph and After paragraph settings.
	None
	Sol-10-7.ppt

	Align Using Grid
	10-8
	Choose Draw, Grid and Guides. Check the box labeled Snap objects to grid. Keep the Display grid on screen option turned on.
	None
	None

	Remove Snap to Grid
	10-9
	Choose View, Grid and Guides. Uncheck the Snap objects to grid option.
	None
	None

	Align Using Guide
	10-10
	Choose View, Grid and Guides. Uncheck the Snap objects to grid and the Display grid on screen boxes. Under Guide settings, check the Display drawing guides on screen box. Switch to Grayscale view to view the guides clearly. Align images using the guides as the reference.
	None
	Sol-10-10.ppt

	Change the Text Anchor Position in an AutoShape
	10-11
	Right-click the placeholder, select Format Placeholder. Click the Text Box tab on the Format AutoShape dialog box. Select a text anchor position from the Text anchor point drop-down list.
	None
	None

	Resize an AutoShape to Fit Text
	10-12
	Right-click the placeholder and select Format Placeholder. Click the Text Box tab on the Format AutoShape dialog box. Check the Resize AutoShape to fit text option.
	None
	None

	Change AutoShape Internal Margins
	10-13
	Right-click the placeholder, select Format Placeholder. Click the Text Box tab on the Format AutoShape dialog box. Change the Internal margin settings.
	None
	None

	Wrap Text in an AutoShape
	10-14
	Right-click the placeholder, select Format Placeholder. Click the Text Box tab on the Format AutoShape dialog box. Check Resize AutoShape to fit text.
	None
	Sol-10-14.ppt

	Change Page Setup for Presentations
	10-15
	Choose File, Page Setup. Choose appropriate options from the Page Setup dialog box.
	None
	Sol-10-15.ppt

	Work with the Notes Master
	10-16
	Choose View, Master, Notes Master.
	None
	None

	Work with the Handout Master
	10-17
	Choose View, Master, Handout Master.
	None
	Sol-10-17.ppt

	Adjust indents using the ruler.
	10-18
	
	EmpAward2.ppt
	Sol-10-18.ppt

	Set tabs, edit tabs, and create tabbed tables.
	10-19
	
	Runner2.ppt

	Sol-10-19.ppt

	Change line spacing and paragraph spacing, align using grids and guides, and customize the handout master.
	10-20
	
	Specials.ppt
	Sol-10-20.ppt

	Change text box settings and page setup options.
	10-21
	
	Upgrade1.ppt
	Sol-10-21.ppt

	Work with indents, tabbed tables, and text box options.
	10-22
	
	Tuscon1.ppt
	Sol-10-22.ppt

	Work with indents, tabs, line spacing, and page setup options.
	10-23
	
	Invent.ppt
	Sol-10-23.ppt

	Work with indents, line spacing, grids, and text box settings.
	10-24
	
	Party2.ppt
	Sol-10-24.ppt

	Create a tabbed table, change line spacing, change text box margins and anchor point settings, and customize the handout master.
	10-25
	
	None
	Sol-10-25.ppt

	
	10-26
	
	None
	None

	
	10-27
	
	None
	None

	
	10-28
	
	None
	None


The outline for this lesson will be presented in the following two sections:



Lecture Outline

· Highlights from the text

· Short discussions on difficult items

Lecture Notes

· Notes

· Teaching tips

· Text figures

· PowerPoint slides

Lesson Outline

Section 10.1

Adjusting Indents by Using the Ruler
This section focuses on:

· Removing Bullets and Adjusting Paragraph Indents
· Changing Indents after Bullets
Section 10.2

Setting Tab Stops, Editing Tab Stops, and Creating a Tabbed Table
This section focuses on:

· Setting Tabs
· Editing Tabs

· Creating Column Headings for a Tabbed Table
Section 10.3

Controlling Line Spacing and Paragraph Spacing
This section focuses on:

· Changing Line Spacing within Paragraphs

· Changing Spacing Between Paragraphs

Section 10.4

Using Grids and Guides to Control Layout
This section focuses on:

· Aligning Using Grid
· Removing Snap to Grid

· Aligning Using Guide

Section 10.5

Working with Text in AutoShapes
This section focuses on:

· Changing the Text Anchor Position in an AutoShape

· Resizing an AutoShape to Fit Text

· Changing AutoShape Internal Margins

· Wrapping Text in an AutoShape

Section 10.6

Working with Page Setup Options
This section focuses on:

· Changing Page Setup for Presentations
Section 10.7

Customizing Handout Masters and Notes Masters

This section focuses on:

· Working with the Notes Master

· Working with the Handout Master

	Lecture Outline
	Lecture Notes

	Section 10.1

Adjusting Indents by Using the Ruler
Each text placeholder has a ruler that can be used to change paragraph indents and tab settings. These settings affect all the text in a placeholder or a text box. Different paragraph settings can be applied to different text by putting them in separate text boxes.
Removing Bullets and Adjusting Paragraph Indents

There are three types of paragraph indents:

· Normal indent—Where all the lines are indented by the same amount from the left margin.
· Hanging indent—Where the first line of the paragraph extends farther to the left than the rest of the paragraph.

· First-line indent—Where the first line of the paragraph is indented farther to the right than the other lines in the paragraph.
The ruler can be used to set indents. If the ruler is displayed, users can view and manipulate indent markers when they activate a text object for editing. Indent markers are the two small triangles and the small rectangle that appears on the left side of the ruler.
Changing Indents after Bullets

Users can change the distance between the bullets and the text in a text placeholder. This can be done by adjusting the spacing between the bullets and the text in a text placeholder by dragging the indent markers on the ruler to the left or right.
	Lesson Key Objective

Explain how to change the indent settings, set tab stops and line spacing, and manipulate text.
Text Figures: F10-01, F10-02


[image: image1.emf]Remove Bullets and  Adjust Paragraph Indents

 
[image: image2.emf]Remove Bullets and  Adjust Paragraph Indents


Teaching Tip:

Explain to students that only the part of a template that is within the slide boundaries will be printed or displayed in a slide show. Extending shapes beyond the edges can expand the design options for a template or an individual slide.
Additional Notes:

The ruler can be displayed by clicking Ruler from the View menu. Ruler is a toggle command.
Additional Notes:

The insertion point must be placed somewhere inside a text box to be able to change settings on the ruler. The appearance of the ruler reflects whether the entire placeholder is selected or the insertion point is active within the placeholder.
Additional Notes:

If a text placeholder contains more than one bullet level, more than one set of indent markers on the ruler can be viewed.
Additional Notes:

Indents can be controlled through the slide master for consistency throughout the presentation. However, formatting applied to individual slides before changing the master cannot be changed by the master slide. To make master slide changes take effect on those slides, reapply the slide layout.
Additional Notes:

Make sure students are aware of the differences between the Apply button and the Apply to All button. Explain that master slide changes never override changes made to individual slides manually. Reapplying a slide layout sets the slide formatting to match the formatting of the master slide.

	Section 10.2

Setting Tab Stops, Editing Tab Stops, and Creating a Tabbed Table

Tabs can be set to create simple tables in PowerPoint. In PowerPoint, by default, tabs are set at 1-inch intervals and are left-aligned.
Setting Tabs

Users can set their own tabs by clicking the Tab Type button in the upper-left corner of the Slide pane and clicking on the ruler.

Editing Tabs

After tabs are set, text keyed by users automatically aligns under the tab markers placed on the ruler. Users can change the position of a text column by dragging its tab marker to a new location on the ruler. To remove a tab marker, users need to drag it down and off the ruler.
Creating Column Headings for a Tabbed Table

Tab and indent settings in PowerPoint affect all the text in a placeholder. Hence, it is advisable to put column headings in a separate text box and align them independently from the table columns.
	Text Figure: F10-03

Teaching Tip:

When creating a tabbed table, it is recommended to work with a text box instead of a body text placeholder so that the indent markers do not interfere with the tabs. To use tabs with a body text placeholder, students must key text before pressing [Tab]. Remind students that when they press [Tab] at the beginning of a line in a body text placeholder, the line is demoted by one bullet level.

[image: image3.emf]Set Tabs
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Additional Notes:

Tabs are set when the tab type symbol appears on the ruler. It might take some practice before you are comfortable with tab type selection and tab placement.
Teaching Tip:

If students have trouble locating the tab positions on the ruler, they can change the zoom to a larger setting. 
Text Figure: F10-04

Teaching Tip:

Explain the purpose of the different tabs with the help of Table 10-1.

Text Figure: F10-05

	Section 10.3

Controlling Line Spacing and Paragraph Spacing

Users can control line spacing by:

· Adding more space between the lines in a paragraph.

· Adding more space between paragraphs.

Increased line spacing can make text layout easier to read and enhance the overall design of a slide.
Changing Line Spacing within Paragraphs

To change spacing between lines within a paragraph, users can:

· Open the Format menu and choose Line Spacing.

· Click the Increase Paragraph Spacing button or the Decrease Paragraph Spacing button on the Formatting toolbar to increase or decrease the space between lines within a paragraph by increments of 0.1 lines.

Changing Spacing Between Paragraphs

Users can change the amount of space before or after paragraphs by using options in the Line Spacing dialog box.


	Additional Notes:
The Increase Paragraph Spacing and Decrease Paragraph Spacing buttons might not appear on the toolbar. To find them, click the Toolbar Options button, click Add or Remove Buttons from the drop-down menu, choose Formatting, and then click the paragraph spacing buttons on the submenu to place them on the Formatting toolbar.
Additional Notes:

The default unit of measurement for line and paragraph spacing is lines. You can change the measurement to points by clicking the arrow next to Lines and choosing Points.


[image: image5.emf]Change Line Spacing  within Paragraphs


Text Figure: F10-06
Teaching Tip:

The naming of the Increase and Decrease Paragraph Spacing buttons might be confusing. These buttons increase or decrease the spacing both within a paragraph and between paragraphs for the text that is selected, or for all text if the text box is selected.
Additional Notes:

If the AutoFit body text to placeholder feature is turned on, the text may automatically be resized. You can control this by clicking the AutoFit Options button that appears at the lower-left corner of a text box.

	Section 10.4
Using Grids and Guides to Control Layout
Grids and guides:

· Make the task of aligning objects easier.
· Provide visible lines that help users determine the location of the objects in relation to other objects and the slide as a whole.

· Are not visible during a presentation.

· Are powerful tools for consistent positioning when designing a presentation.

Aligning Using Grids
The Grid and Guides dialog box can be used to set up a visible or invisible grid.

There are three ways to access the Grid and Guides dialog box:

· Choosing Grid and Guides from the View menu.
· Clicking Draw on the Drawing toolbar and choosing Grid and Guides.

· Pressing [Ctrl]+[G].
Removing Snap to Grid
When users want complete control over the positioning of their objects, they need to turn off the Snap objects to grid feature. When this feature is disabled, users can also fine-tune object positioning by using the arrow keys.
Aligning Using Guides

Guides offer a great degree of flexibility. They can be added, removed, and repositioned without opening a dialog box. Guides aid in the alignment and positioning of objects on a slide. Users can move a guide by dragging it with the standard mouse pointer.

The following keyboard shortcuts can be used when working with guides:

· [Shift]             To measure the distance from the guide’s starting position to its new position.

· [Ctrl]              To add a new guide.

· [Shift]+[Ctrl]   To add a new guide at a measured distance from an existing guide.


	Text Figures: F10-07, F10-08

[image: image6.emf]Align Using Grids
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Additional Notes:

Use the [Alt] key to remove the Snap to grid feature temporarily.
Teaching Tip:

Remind students that they need to click the Color/Grayscale button on the Standard toolbar and choose Grayscale from the submenu to switch to Grayscale view.
Text Figures: F10-09, F10-10

Additional Notes:

If you release [Ctrl] before releasing the mouse button, the result will be moving the line, not adding a new one.

Additional Notes:

You can add up to eight horizontal and eight vertical guides. When you no longer need them, simply drag them off the slide. You can remove all but one set of guides this way. You can hide the remaining set of guides, but cannot remove them.

	Section 10.5
Working with Text in AutoShapes
Users can change the position of text within its text box or AutoShape by changing its text anchor point. Users can also change the text box margins, the text box size, and the word-wrap options. These options are found on the Text Box tab of the Format AutoShape dialog box.

Changing Text Anchor Position in an AutoShape

The text anchor point defines the position of the text within a text box, text placeholder, or AutoShape.
The six defined text anchor positions are:

· Top
· Middle
· Bottom
· Top Centered
· Middle Centered
· Bottom Centered

The default text anchor position in an AutoShape is Middle Centered. This anchor position remains fixed when text shrinks and grows during editing, or when the size of the AutoShape or the placeholder is changed.
Resizing an AutoShape to Fit Text
The Resize AutoShape to fit text option is located on the Text Box tab of the Format AutoShape dialog box. When users choose this option, the text box or the AutoShape automatically shrinks or grows as text is added or deleted or when the font size is changed.
Changing AutoShape Internal Margins

In an AutoShape, users can change the space between the text and the border by changing the Internal margin settings on the Text Box tab of the Format AutoShape dialog box.

Wrapping Text in an AutoShape

When users key text in an AutoShape, the text is automatically anchored at the middle center position, and the word wrap and resize AutoShape features are turned off. These default settings can be changed by users so that text fits into an AutoShape.
	Teaching Tip:

Explain text box options on the Format AutoShape dialog box with the help of Table 10-3.

[image: image8.emf]Work with Text in  AutoShapes

 
[image: image9.emf]Change Text Anchor  Position in an AutoShape


Text Figures: F10-11, F10-12

Additional Notes:

To change an AutoShape, click Draw on the Drawing toolbar and choose Change AutoShape, Basic Shapes.

Text Figure: F10-13

	Section 10.6
Working with Page Setup Options
By using the settings on the Page Setup dialog box or the Print dialog box, PowerPoint presentations can be distributed and delivered in one of the following ways:

· As an on-screen slide show.
· As overhead transparencies.
· As 35-mm slides.
· As color or black-and-white printouts.
The Page Setup dialog box can be used to alter the built-in page settings of a presentation. Changing page settings can change the proportions or orientation of a page layout.
Changing Page Setup for Presentations

Users can change the page setup by choosing Page Setup from the File menu.
	
[image: image10.emf]Work with Page  Setup Options


Text Figure: F10-14

Teaching Tip:

Ensure that students understand the difference between the landscape and the portrait orientation.

	Section 10.7
Customizing Handout and Notes Master
The notes master and the handout master control the overall look and formatting of notes and handouts. The handout and notes master can be customized.
Working with the Notes Master

On a notes master, users can:

· Format, resize, and reposition the notes text placeholder, the slide placeholder, and the header and footer placeholders.

· Add pictures, text boxes, and other AutoShapes.

· Delete placeholders.
The Notes Master Layout button on the Notes Master View toolbar can be used to restore a deleted placeholder.

The notes master can be accessed by selecting Master from the View menu, and choosing Notes Master from the submenu.
Working with the Handout Master

On a handout master, users can make the same kinds of changes as on the notes master, except that the handout master cannot alter the size or position of the slide placeholders.
Handout masters come with six different prearranged layouts ranging from one to nine slides on a page.
The handout master can be accessed by selecting Master from the View menu, and choosing Handout Master from the submenu.
	Text Figures: F10-15, F10-16

[image: image11.emf]Work with the Notes  Master


Additional Notes:
When placing pictures or other objects on a handout master, you must be careful to size and position them so that they do not overlap the slide placeholders.


[image: image12.emf]Work with the  Handout Master


Teaching Tip:

Ask students to open the Page Setup dialog box to view the changed orientation setting. Point out that until now, all handouts were printed in portrait orientation.

Teaching Tip:

Point out to students that they can apply a background color or pattern to the handout or notes master. Right-click a blank area on the handout or notes master and notice the options on the shortcut menu.
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